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What Is Paintbrush?
With Windows Paintbrush you can create simple or elaborate color drawings like the following:

Before you begin drawing, take time to learn the parts of the Paintbrush window. Then, try creating a 
simple drawing. When you are ready, experiment with the drawing tools and the special features for 
cutouts and detail work.



The Paintbrush Window
You create, edit, and view your drawings in the Paintbrush window.
Click the green text below to read more about the Paintbrush window.



toolbox
Contains the tools you use to create your drawing. With the tools, you can draw, fill objects, paint, erase,
and rearrange items in the drawing area. You can also enter text.



drawing area
The area in which you create your drawings. The standard size of your drawing area depends on your 
video display and the amount of free memory you have. You can change the size of the drawing area.
If parts of your drawing are off the screen, you can enlarge the drawing area or use the scroll bars to 
bring them into view.



pointer
The object on the screen that follows the mouse's movement and indicates which area of the screen will 
be affected when you click the mouse button. Outside the drawing, the pointer is usually arrow-shaped. 
In the drawing, the pointer is usually cross-shaped. However, if you select the text tool, the pointer 
changes to an I-beam; if you select the Paint Roller, the pointer changes to a Paint Roller.



linesize box
Indicates the available line widths. The arrow points to the current width.



palette
Contains the colors and patterns available for the background of the drawing area and for drawing in the
foreground.



foreground and background color
Colors used in a drawing's foreground and background. In this example, the foreground color (black) sits
on top of the background color (white). The foreground color is the color you draw with. The background 
color is the color you draw on.



Drawing Size
The first time you start Paintbrush, it establishes a standard size for the drawing area. The size is based 
on your type of video display and the amount of memory available. You can change the standard 
drawing size.
For example, your standard drawing size may be 640 pels wide by 480 pels high. This is about 6.6 by 5 
inches. You can change this to your paper size, probably about 8 inches wide and 10.5    inches high. 
Large drawings use more memory, both RAM and disk space. If your picture will be smaller than the 
standard drawing size, it is best to reduce the drawing area size.

Related Procedure



Simple Drawings
The easiest way to begin a drawing is to select a drawing tool and then draw with it. For example, to 
draw a house, you might select the Box tool and drag the pointer through the drawing area to create a 
rectangle.

When you start Paintbrush, you draw with black on a white background. You can change the color you 
draw on (background color) and the color you draw with (foreground color).    

Related Procedures



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting and Using a Drawing Tool





Text

You can add text to any drawing. The text can be any color, font, size, or style that Paintbrush supports. 
You can change these options or edit your text until you paste down the text.
When you type, Paintbrush does not automatically wrap text at the end of a line. You must press the 
ENTER key to move text to the next line. If you make a mistake, you can use the BACKSPACE key to 
correct it.

Related Topics



Procedure
Copying, Cutting, and Pasting Cutouts

Tool
Text Tool



text color
A solid color. If you select a pattern or non-solid color for text, the text is drawn in the closest solid color.



font style
The graphic qualities of the text. You can make text bold, italic, and underlined. You can also put an 
outline or shadow around the text.



How to Edit a Drawing
Paintbrush provides a variety of tools and functions for changing your drawing. Until you paste down 
part of a drawing, you can edit it with the BACKSPACE key and the Undo command. After you paste it 
down, you have three other ways to change the drawing.

Erase part of the drawing with the Eraser tool.
Change colors with the Color Eraser tool.
Define and work with a cutout.
Related Topics



Procedure
Editing Graphics

Tools
Eraser
Color Eraser



Cutouts
A cutout is an area you define with the Pick tool or the Scissor tool.        Paintbrush provides several 
special effects for working with cutouts. You can use any combination of these to create custom 
drawings.

You can cut, copy, and paste a cutout to and from the Clipboard. If the cutout is larger than the 
drawing area, you need to choose Zoom Out from the View menu before you paste the cutout.

You can move a cutout within the drawing area.
You can sweep a cutout. Sweeping leaves a trail of copies behind when you move the cutout.    

You can flip a cutout horizontally or vertically.    

You can shrink or enlarge a cutout to a different size.    

You can tilt a cutout on an angle.    

You can invert the colors in a cutout.    

You can save a cutout to a file.
You can paste a cutout from a file.
Related Procedures



Procedures
Copying, Cutting, and Pasting Cutouts
Displaying All of a Drawing
Flipping Cutouts
Inverting Colors in Cutouts
Moving Cutouts
Moving a Cutout and Leaving a Copy
Retrieving Cutouts
Saving Cutouts
Shrinking and Enlarging Cutouts
Sweeping Cutouts
Tilting Cutouts



Use the Pick tool to define a rectangular cutout, as shown in the following:

Use the Scissors tool to draw a cutout freehand, as shown in the following:













paste down
Make the most recent drawing or text permanent. The current drawing or text is pasted down when you 
do any of the following:

Select a tool.
Use a scroll bar.
Open another application.
Change the size of the window.
Reposition the text insertion point when using the Text tool.

Once part of a drawing or text is pasted down, you cannot change it with the BACKSPACE key or the Undo
command.



Detail Work
Paintbrush provides two ways to work with fine details in your drawing: the Cursor Position command 
and the Zoom In command.
You can use Cursor Position to see the x-y coordinates of the pointer. You can use the coordinates to 
place your lines or text accurately.

You can use Zoom In to magnify a portion of your drawing. You can then change your drawing one pixel 
at a time, making the finishing touches to your picture.

Related Procedures



Procedures
Editing with Zoom In
Using the Cursor Position Option



Custom Colors

Every color and pattern in Paintbrush is made by mixing red, blue and green. Changing the mix of these 
primary colors creates a new color.    
You can create custom colors and patterns by varying the amounts of red, green, and blue. You can 
change colors at any time. Changing a color while you are creating a drawing gives you a new color to 
use.    It does not change the colors you have already used.

Related Procedure



The following example shows the kind of colors you get by mixing red, green, and blue:

In a monochrome monitor, each of the numbers for red, green, and blue must always stay the same, 
although you can change them as a group as show in the following example:



How Paintbrush Prints
When Paintbrush prints a drawing, it preserves the proportions of the drawing. (Objects such as squares
and circles do not become rectangles and ellipses on the printed page.)
When you print, you can tell Paintbrush to:

Print all of the drawing.
Paintbrush can print either a draft or proof copy. You can also scale your drawing to a different size.

Print part of the drawing.
Add header or footer text to each page. This might be explanatory text, the date, a page number, 

or the filename.
Adjust the margins for the picture.
Related Procedures



Procedures
Printing Drawings
Printing Headers and Footers
Printing Part of a Drawing
Setting Margins



draft
Describes an unenhanced copy of the drawing printed with the fastest printer speed.



proof
Describes a high quality copy of the drawing printed with the printer's advanced features.



File Formats
You can save your Paintbrush drawings in four bitmap formats or as Paintbrush files. Unless you change
the setting, Windows automatically saves a new drawing in one of the bitmap formats. The standard 
bitmap format for your drawing depends of the type of display you have. Paintbrush saves an existing 
drawing that you open and edit in its original file format, unless you specify otherwise. The format 
options are:

PCX (Paintbrush file)
Monochrome bitmap
16 color bitmap
256 color bitmap
24-bit bitmap

You should save images in a bitmap format whenever possible. Doing this maintains compatibility with 
other Windows applications and with future versions of Windows.

Related Procedure















Style menu commands affect text in the drawing area and text you type until you select a tool, use 
a scroll bar, open another application, or reposition the text cursor. Except for Normal, choosing a 
style again cancels the style.









New Command

Creates a new drawing area.
The workspace for the new drawing uses the settings specified with the Image Attributes command. In 
addition, if you selected a new background color, the New command displays it.
When you choose the New command, Paintbrush lets you saves changes to the current drawing before 
creating a new drawing area.

Related Procedure



Open Command

Opens an existing file.
Choose the Info button to see the height, width, and number of colors and planes in the file.
Choose BMP, MSP, or PCX to find files in the selected format in the current directory.
When you choose this command, Paintbrush lets you save changes to the current drawing before 
opening a new file.

Related Procedure



Save Command

Saves changes to the current drawing.
When you choose this command, the drawing remains open so you can continue working on it.

Related Procedure



Save As Command

Saves a new drawing or existing drawing under another name.
You might want to rename a file so that you can change an existing file without modifying the original.
Unless you change the setting in the Save As dialog box, Paintbrush automatically saves a new drawing
in the bitmap (.BMP) format. It saves a drawing that you open and edit in the same format that it was 
opened in. Choose Options to change the format of the drawing you want to save.
If you are concerned about the amount of disk space needed to store a drawing, you can choose the 
Info button to see the size of and number of colors in the drawing before you save it. The larger the size 
of the drawing and the more colors used, the more disk space it requires.

Related Procedure



Page Setup Command

Sets the margins, and adds headers and footers to the printed drawing.
Use this command to position your drawing on the page when you print it. Otherwise, Paintbrush will use
the standard margin settings when it prints the drawing.
When specifying headers or footers, type text or use the following codes:

Type To do this
&d Enter the current date.
&p Enter page numbers.
&f Enter the current filename.
&l Justify the text that follows at the left margin.
&r Justify the text that follows at the right margin.
&c Center the text that follows in the top or bottom margin. This is the default.
&t Enter the current time.

Related Procedures



Procedures
Printing Headers and Footers
Setting Margins



Print Command

Prints a drawing.
You can specify:

Draft or proof quality printing.
Whole or partial printing of the drawing.
Number of copies.
Printing at printer resolution rather than screen resolution.

If you have connected and installed a printer, you can print the drawing. Paintbrush automatically prints 
with the default printer.

Related Procedures



Procedures
Installing New Printers
Printing Drawings



Printer Setup Command

Sets printer options for Paintbrush before printing.
You can:

Select a default printer for Paintbrush.
Choose Setup and change options for the printer.

The available options depend on the type of printer selected.
Related Procedure



Exit Command

Exits Paintbrush and closes the Paintbrush window.
If the drawing is unsaved, Paintbrush lets you save it before exiting.



Undo Command

Undoes the most recent drawing or editing action.
You can use Undo until you do any of these things:

Select a tool.
Use a scroll bar.
Open another application.
Resize the window.

As soon as you do any of these, Paintbrush pastes down the objects currently in the drawing area, and 
Undo no longer functions.

Related Procedures



Procedures
Editing Graphics with Undo
Editing with Zoom In



Cut Command

Removes a cutout from your drawing and places it onto the Clipboard, erasing the previous Clipboard 
contents.
Use Paste to place the cutout in another place in the current drawing, in another drawing, or in another 
application.

Related Procedure



Copy Command

Copies a cutout from your drawing onto the Clipboard, erasing the previous Clipboard contents.
Use Paste to place the cutout in another place in the current drawing, in another drawing, or in another 
application.

Related Procedure



Paste Command

Pastes the Clipboard contents in the upper-left corner of the drawing.
Paste inserts the Clipboard contents into a box in the upper left-corner of the drawing. You can drag the 
box to another part of the drawing. To paste down the image in the box, click outside the box.

Related Procedure



Copy To Command

Saves a cutout in a file.
You can save a cutout as a Paintbrush file (.PCX) or as a bitmap file (.BMP). Unless you change the 
setting in the Save As dialog box, Windows automatically assigns the extension .BMP and saves your 
cutout as a Windows bitmap. Choose Options to specify the format in which you want to save the cutout.
If you are concerned about the amount of disk space needed to store a cutout, you can choose the Info 
button to see the size of and number of colors in the cutout before you save it. The larger the size of the 
cutout and the more colors used, the more disk space it requires.

Related Procedure



Paste From Command

Retrieves a cutout from a file and places it in a drawing.
Select BMP, MSP, or PCX to find files in the selected format in the current directory.
If you're concerned about the amount of disk space a cutout uses, choose the Info button to see the 
height, width, and number of colors and planes in the cutout.
Paste From inserts the cutout into a box in the upper left-corner of the drawing. You can drag the box to 
another part of the drawing. To paste down the image in the box, click outside the box.

Related Procedure



Zoom In Command

Magnifies part of a drawing so you can change a pixel at a time, or returns a drawing to normal 
resolution after you shrink it with Zoom Out.
When the drawing is at normal resolution and you choose Zoom In, the pointer changes to a rectangle. 
Click the rectangle over an area you want to display in detail.
The left mouse button changes a pixel to the foreground color. The right mouse button changes a pixel 
to the background color. Dragging changes a wide area of pixels.
Use the Paint Roller tool to change an area within the magnified area.    
In the small box in the upper-left corner of the drawing area, you can see how changes you make to the 
magnified area look at normal resolution.

Related Topics



Procedures
Displaying All of a Drawing
Editing with Zoom In

Tool
Paint Roller



Zoom Out Command

Shrinks a drawing to fit the drawing area, or returns a drawing to normal resolution after you magnify it 
with Zoom In.
With Zoom Out, you can view a drawing that is larger than the drawing.
With Zoom Out, you can copy, cut, and paste cutouts; however, you can't use the drawing tools.
When you use Zoom Out to view a drawing, you might not see some of the line detail in the drawing. 
Generally, the larger the size of your original, the greater the amount of line detail that you lose when 
Paintbrush shrinks the drawing. You see this loss of detail only in the compacted version of the drawing. 
It does not affect your full-size drawing.

Related Procedures



Procedures
Copying, Cutting, and Pasting Cutouts
Displaying All of a Drawing
Editing with Zoom In



View Picture Command

Removes everything but the drawing from the screen.
Use View Picture to view more of your drawing. Because the menus, Toolbox, Palette, Linesize box, and
even the cursor disappear when you choose View Picture, you cannot edit your drawing in any way.

Related Procedure



Tools and Linesize Command

Removes the Toolbox and Linesize box from the Paintbrush window.
Use Tools and Linesize to view more of your drawing. You can still use the selected tool, drawing width, 
and color as well as the menu commands when the Toolbox and Linesize box are not visible on the 
screen.

Related Procedure



Palette Command

Removes the Palette from the Paintbrush window.
Use Palette to view more of your drawing. You can still use the selected tool, drawing width, and color as
well as the menu commands when the Palette is not visible on the screen.

Related Procedure



Cursor Position Command

Displays the pointer position as x-y coordinates.
Use these width and height coordinates to align text or lines in your drawings. Cursor Position is 
particularly helpful when you create charts and tables.

Related Procedure



Font Names

Changes text to a different font.
The Font menu lists all available fonts. When you choose a font name, the command changes the font 
of text in the drawing area and text you type until you select a tool, use a scroll bar, open another 
application, or reposition the text cursor.

Related Procedure



Normal Command

Cancels bold, italic, underline, outline, and shadow character styles.
Related Procedure



Bold Command

Makes text bold.
Related Procedure



Italic Command

Italicizes text.
Related Procedure



Underline Command

Underlines text.
Related Procedure



Outline Command

Outlines text.
The outline is in the current background color.

Related Procedure



Shadow Command

Creates a shadow around text.
The shadow is in the current background color.

Related Procedure



Font Sizes

Changes the size of text to the font size you choose from the menu.
The Size menu lists a range of point sizes for all the fonts. Font sizes available with the selected font 
appear in black. Font sizes that can't be used are dimmed. Font sizes followed by an asterisk are 
precision-drawn font sizes provided by a font file. Font sizes without an asterisk are font sizes that are 
scaled by Windows to approximate the size indicated.
The availability of point sizes depends on the resolution of your printer. If no printer is installed, the 
available point sizes are based on the screen resolution of your video display.

Related Procedure



Flip Horizontal Command

Flips a cutout from side to side.
Related Procedure



Flip Vertical Command

Flips a cutout from top to bottom.
Related Procedure



Inverse Command

Inverts the colors in a cutout.
In a black and white drawing, black becomes white and white becomes black. In a color drawing, a color
changes to its complementary color.

Related Procedure



Shrink+Grow Command

Changes the size of a cutout.
When you choose this command, you drag a flexible box to define the new size of the cutout. The cutout
shrinks or enlarges to fit the dimensions of the box. Before you choose this comand, choose the Clear 
command to move the cutout instead of copying it.

Related Procedure



Tilt Command

Tilts a cutout.
When you choose this command, you press and hold down the mouse button to anchor a flexible box, 
then move the mouse to tilt the cutout. The cutout will be defined by the flexible box. Before you choose 
this comand, choose the Clear command to move the cutout instead of copying it.

Related Procedure



Clear Command

Fills in the cutout area with the background color when you choose the Shrink+Grow or Tilt command. 
This has the effect of erasing the contents of the area.
Choose Clear before you choose Shrink+Grow or Tilt to move the original cutout to the area defined by 
the Shrink+Grow or Tilt commands. If you don't choose Clear, the original cutout remains intact.

Related Procedures



Procedures
Shrinking and Enlarging Cutouts
Tilting Cutouts



Image Attributes Command

Specifies the settings for a new drawing.
With this command, you can specify the drawing size, the unit of measurement, and whether you want 
the drawing displayed in colors or black and white. Choose Default to return the drawing area to the 
original size.
The settings you specify take effect when you start a new drawing with the New command.

Related Procedure



Brush Shapes Command

Changes the shape of the Brush tool.
When you choose this command, you see a dialog box with six choices of brush shapes. A faster way of 
opening this dialog box is to double-click the Brush tool in the Toolbox.

Related Tool



Edit Colors Command

Creates a custom color and places it in the palette.
When you choose this command, three scroll bars are displayed in the dialog box. Move the scroll boxes
to the left or right to vary the amounts of red, green, and blue (or RGB components) present in a color 
selected in the Palette.
You can change colors and patterns at any time. Changing colors and patterns in mid-drawing does not 
affect your drawing in any way other than to provide you with more color options.

Related Procedure



Get Colors Command

Retrieves color palettes saved in a file.
Use this command to retrieve color palettes to which you've added custom colors.
Retrieve a color palette file as you would other Paintbrush files.

Related Procedure



Save Colors Command

Saves color palettes in a file.
Use this command to save color palettes to which you've added custom colors.
Save a color palette file as you would other Paintbrush files. If you don't specify an extension, the 
extension .PAL is automatically assigned to the filename. If you specify an extension, it overrides any 
automatic extension.

Related Procedure
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Changing Default Settings for New Drawings
When you start Paintbrush, it uses default settings. For example, Paintbrush establishes a standard size
for a drawing area based on your type of video display and the amount of memory available. If you want 
to create a drawing that is larger or smaller than the standard size established by Paintbrush, you can 
change the standard drawing size.

To change default settings for a new drawing:
1 Choose Image Attributes from the Options menu.
2 Select the settings you want.

This setting Specifies
Width The drawing width.
Height The drawing height.
Units The unit of measurement you want to use when you enter the width and height of 

your drawing.
Select inches (in), centimeters (cm), or picture elements (pels).

Colors Whether you work in color or black and white.
Default That Paintbrush return the drawing area to the original size used to accommodate 

your video display.
3 Click OK.
4 Choose New from the File menu to start a drawing with the new settings.

Or double-click the Eraser tool in the Toolbox to start a new drawing.
Paintbrush now uses the new settings in the Image Attributes dialog box each time you start 
Paintbrush.
Keep in mind that the larger the drawing and the more colors you use, the more memory required. If 
you plan to print your drawing at printer resolution, be sure that you enter the correct dimensions (in 
pixels) for the printed drawing in the Image Attributes dialog box. Also, be sure that the dimensions 
you specify are in proportion to the current screen dimensions of the drawing. Because printing at 
printer resolution requires more memory, you cannot print as large a drawing as you can printing at 
screen resolution.

Keyboard Procedure



Starting New Drawings
To start a new drawing:
1 Select new background and foreground color  s   for your drawing if you want to.
2 Change the default settings for the drawing if you want to.
3 Choose New from the File menu.
4 Select a tool and start drawing.

Keyboard Procedure



Selecting Background and Foreground Colors
You can change the foreground color at any time while creating a drawing. You can also change the 
background color at any time and, by doing so, create special effects with tools and commands that use 
the background color to draw.

To select a different background color:
Point to the color in the Palette and click the right mouse button.

To set the background color for a new drawing:
Choose New from the File menu.

To select a different foreground color:
Point to the color in the Palette and click the left mouse button.
Keyboard Procedure



Selecting a Drawing Width
The Linesize box in the lower-left corner of the Paintbrush window displays the available drawing widths.
The top line represents a one-pixel width. The drawing width determines the width of an object you draw 
or the thickness of the border around the object.    .

To select a drawing width:
Point to a width in the Linesize box and click the mouse button.
Keyboard Procedure



example
If you are drawing a line, the selected drawing width determines the width of the line. If you are drawing 
a filled box, the selected drawing width determines the thickness of the border around the box. You 
might want to experiment with how different drawing widths work with different tools so that you can use 
them most effectively.



Selecting and Using a Drawing Tool
Before you begin working in the drawing area, you need to select the tool you want to work with from the
Toolbox at the left of the Paintbrush window.

To select a drawing tool:
Point to the Airbrush, Brush, or Paint Roller tool and click the mouse button.

To draw with a selected tool:
1 Move the pointer into the drawing area.
2 Position the pointer where you want to start drawing.
3 Drag the pointer through the drawing area.

If you are drawing an object such as a box or circle, the object expands and contracts, following the 
pointer's movements.

4 Release the mouse button when you are finished drawing the object.
Keyboard Procedure



Editing Graphics
If you make a mistake while drawing, you can use the Undo command on the Edit menu or the 
BACKSPACE key to make simple corrections.

To delete everything you have drawn since selecting a tool:
Choose Undo from the Edit menu.

Using just BACKSPACE lets you delete a portion or all of what you have drawn since selecting the tool you
are currently working with. BACKSPACE is particularly handy for small cleanup jobs such as deleting stray 
dots made by the Airbrush.

To delete a portion of what you have drawn since selecting a tool:
1 Press BACKSPACE.

The pointer turns into a square with an X inside. The size of the square depends on the selected 
drawing width.

2 Drag the pointer over parts of the drawing you want to delete.
3 Release the mouse button when you finish.
4 Press the mouse button again to continue drawing with the selected tool.
You can use Undo and BACKSPACE until you do any of these things:

Select a tool.
Use a scroll bar.
Open another application.
Resize the window.

Once you do any of these, Paintbrush pastes down the objects currently in the drawing area, and Undo 
and BACKSPACE no longer work. You must now use an eraser tool or select and edit a portion of your 
drawing called a cutout.    

Related Tool
Keyboard Procedure



hint
To prevent undoing work that you are satisfied with, protect that section of your drawing from Undo and 
BACKSPACE by reselecting the tool you are currently working with or by taking one of the other actions in 
the previous list. Then Undo and BACKSPACE can delete only your most recent work.



Showing the Entire Screen
With the View Picture command, you can display as much of your drawing as fits on the entire screen by
temporarily removing everything but your drawing. Because the menus, Toolbox, Palette, Linesize box, 
and even the cursor disappear when you choose View Picture, you cannot edit your drawing in any way.

To display your drawing on the entire screen:
Choose View Picture from the View menu.

Or double-click the Pick tool in the Toolbox.
To cancel View Picture, click the mouse button or press ESC.

Related Procedure
Keyboard Procedure



Displaying All of a Drawing
If you create a drawing that is larger than the drawing area and the entire screen, you can still view all of
the drawing on the screen at one time.

To display all of a drawing that is larger than the drawing area:
Choose Zoom Out from the View menu.

Zoom Out shrinks the drawing to fit the drawing area.
You can still copy, cut, and paste cutouts; however, you can't use the drawing tools.
To cancel Zoom Out, choose Zoom In from the View menu or press ESC.
When you use Zoom Out to view a drawing, you might lose some of the line detail in the drawing. 
Generally, the larger the size of your original, the greater the amount of line detail that you lose when 
Paintbrush shrinks the drawing. You see this loss of detail only in the compacted version of the 
drawing. It does not affect your full-size drawing.

Related Procedure
Keyboard Procedure



Enlarging the Drawing Area
You can remove the Toolbox, Linesize box, and Palette from the Paintbrush window to increase the size 
of the drawing area. You can still use the selected tool, drawing width, and color as well as the menu 
commands when the Toolbox, Linesize box, and Palette are not visible on the screen.

To remove the Toolbox and Linesize Box:
Choose Tools and Linesize from the View menu.

To redisplay the Toolbox and Linesize box, choose Tools and Linesize again.

To remove the Palette:
Choose Palette from the View menu.

To redisplay the Palette, choose Palette again.
Related Procedures
Keyboard Procedure



Procedures
Displaying All of a Drawing
Showing the Entire Screen



Editing with Zoom In
With the Zoom In command, you can magnify a portion of a drawing so you can make changes on a 
pixel-by-pixel basis.

To magnify a portion of a drawing and change a pixel at a time:
1 Choose Zoom In from the View menu.

The pointer changes to a movable rectangle.
2 Place the rectangle over the area you want to magnify.
3 Click the mouse button.

Paintbrush magnifies the portion of your drawing enclosed by the rectangle.
In the small box that appears in the upper-left corner of the drawing area, you can see your changes 
at normal resolution.

4 Point to pixels you want to edit and click either mouse button.
Clicking the left mouse button changes a pixel to the foreground color. Clicking the right mouse button
changes a pixel to the background color. Dragging changes a wide area of pixels.
Use the Paint Roller tool to change an area within the magnified area.    

5 Choose Zoom Out from the Edit menu when you finish.
Or choose Undo from the Edit menu to return to the normal resolution and cancel any changes made 
to your drawing.

Related Tool
Keyboard Procedure



hint
If you use the Paint Roller tool with a full-size drawing and the paint leaks through the border of an 
object and fills the drawing area, choose Undo and use Zoom In to patch the areas where the paint 
leaked through.



Copying, Cutting, and Pasting Cutouts
To copy and paste or cut and paste a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Choose Copy from the File menu to copy the cutout.

Or choose Cut from the File menu to cut the cutout.
3 Open the file you want to paste the cutout in.
4 Choose Paste from the Edit menu.

You cannot paste a cutout larger than the current drawing area unless you have zoomed out to 
display your entire drawing. If you try, Paintbrush pastes only the part of the cutout showing in the 
drawing area.

5 Move the pointer inside the cutout.
If you are working in Zoom Out mode, the image will not appear inside the cutout frame.

6 Press the left mouse button to paste the cutout transparently.
Or press the right mouse button to paste the cutout opaquely.
If you are working in Zoom Out mode, you can only paste the cutout opaquely.

7 Drag the cutout where you want it.
8 Click outside the cutout to paste down the cutout.

If the drawing you are pasting to is in Zoom Out mode, the cutout frame may be hidden by the image 
boundaries. In that case, you may have to click the gray area just outside the drawing area to paste 
down the cutout.

Related Tools
Keyboard Procedure



Tools
Pick Tool
Scissors Tool



Moving Cutouts
To move a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Move the pointer inside the cutout.
3 Press the left mouse button to paste the cutout transparently.

Or press the right mouse button to paste the cutout opaquely.
4 Drag the cutout.
5 Release the mouse button when the cutout is where you want it.
6 Click outside the cutout to paste down the cutout.

Related Tools
Keyboard Procedure



Tools
Pick Tool
Scissors Tool



Moving a Cutout and Leaving a Copy

To move a cutout and leave a copy behind:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Move the pointer inside the cutout.
3 Press and hold down the SHIFT key.
4 Press the left mouse button to paste the cutout transparently.

Or press the right mouse to paste the cutout opaquely.
5 Drag the cutout.
6 Release SHIFT once you have moved the cutout away from the copy.
7 Release the mouse button when the cutout is where you want it.
8 Click outside the cutout to paste down the cutout.

Related Tools



Tools
Pick Tool
Scissors Tool



Sweeping Cutouts
When you sweep a cutout, you move the cutout across the drawing area, leaving a trail of copies of the 
cutout behind.

To sweep a cutout across the drawing area:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Move the pointer inside the cutout.
3 Press and hold down the CTRL key.
4 Press the left mouse button to paste the cutout transparently.

Or press the right mouse button to paste the cutout opaquely.
5 Drag the cutout.
6 Release CTRL and the mouse button when you finish.
7 Click outside the cutout to paste down the changes.

Related Tools
Keyboard Procedure



Tools
Pick Tool
Scissors Tool



Transparent and Opaque Pasting and Sweeping
Whenever you paste or sweep a cutout, you have the option of pasting or sweeping transparently or 
opaquely. If you paste or sweep transparently, any part of your drawing covered by the cutout shows 
through. If you paste or sweep opaquely, the entire cutout area covers whatever part of the drawing is 
underneath it.
If you want to paste or sweep transparently, the background color for the cutout and the currently 
selected background color must be the same. Otherwise, the object you paste or sweep won't be 
transparent.    



hint
If you want to sweep a cutout opaquely across the screen, you might want to define a freeform cutout. If 
you create a cutout that closely encircles the object you want to sweep, the shape that you sweep is 
only the defined object. If you define a rectangular cutout, you get the object inside a box of background 
color.



Saving Cutouts
You can save a cutout as a Paintbrush file (.PCX) or as a bitmap file (.BMP).

To save a cutout to a file:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Choose Copy To from the Edit menu.
3 If you want to save the file in the current directory, type the filename.

If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

4 Choose Options to specify the format in which to save the cutout.
5 Click the Info button to see the height, width, and number of colors and planes in the cutout. Then 

click OK.    
6 Click OK.

Related Topics
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Retrieving Cutouts

Tools
Pick Tool
Scissors Tool



hint
If you are concerned about the amount of disk space needed to store a cutout, you can click the Info 
button in the Copy To dialog box to see the size of and number of colors in the cutout before you save it. 
The larger the size of the cutout and the more colors used, the more disk space it requires.



Retrieving Cutouts
You can use the Paste From to retrieve a cutout from disk and place it in the drawing area. The cutout 
appears in a flexible rectangle in the upper-left corner of the drawing area. (The Pick cutout tool at the 
top right of the Toolbox is automatically selected.) You need to move the cutout to the location where you
want it to appear permanently in the drawing area .

To retrieve a cutout from a file:
1 Choose Paste From from the Edit menu.
2 If the file is in the current directory, select the name of the file in the Files box.    

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
select the name of the file in the Files box.

3 Click the Info button to see the height, width, and number of colors and planes in the cutout. Then 
click OK.

4 Click OK.    
5 Move the pointer inside the flexible box in the upper-left corner of the drawing area. Then press the 

mouse button.
6 Drag the cutout where you want it and release the mouse button.
7 Click outside the cutout to paste it down.

CAUTION: If you paste a previously saved color drawing into a black and white drawing, Paintbrush 
translates the colors into black and white.

Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Saving Cutouts



hint
To find files with a different extension, type that extension in the Filename box and then click OK.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



Flipping Cutouts
You can use the Flip Horizontally command from the Pick menu to flip a cutout from side to side. Flip 
Vertically flips a cutout from top to bottom.

To flip a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Choose Flip Horizontal or Flip Vertical from the Pick menu.
3 Select any tool to paste down the cutout.

Related Tools
Keyboard Procedure



Tools
Pick Tool
Scissors Tool



Tilting Cutouts
To tilt a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Choose Tilt from the Pick menu.
3 Choose Clear from the Pick menu if you want to cut the original cutout area after tilting the cutout.
4 Move the pointer where you want to anchor the upper-left corner of the flexible box that you use to 

determine the angle of tilt.
Since you are tilting a copy of your cutout, you can anchor this box anywhere in your drawing.

5 Press and hold down the left mouse button when the pointer is where you want to anchor a corner of 
a flexible box.
The angle of the cutout will be defined by your placement of the flexible box.

6 Drag the mouse left or right.
The bottom of the flexible box shifts with the mouse.

7 Select any tool to paste down the cutout.
Related Tools
Keyboard Procedure



Tools
Pick Tool
Scissors Tool



Shrinking and Enlarging Cutouts
To change the size of a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Choose Shrink+Grow from the Pick menu.
3 Choose Clear from the Pick menu if you want to remove the original cutout area after shrinking or 

enlarging the cutout.
4 Move the pointer where you want to anchor the upper-left corner of the flexible box that you use to 

change the dimensions of your cutout. Then press and hold down the mouse button.
The size of the cutout will be defined by the flexible box.

5 Drag the Shrink+Grow box from the anchored corner until you are satisfied with its dimensions.
Or hold down the SHIFT key and drag the box to keep the same proportions as the original.

6 Release the mouse button.
The cutout shrinks or enlarges to fit the dimensions of the box.

7 Select any tool to paste down the cutout.
Related Tools
Keyboard Procedure



Tools
Pick Tool
Scissors Tool



Inverting Colors in Cutouts
With the Inverse command, you can invert the colors in a cutout. In a black and white drawing, black 
becomes white and white becomes black. In a color drawing, a color changes to its complementary 
color.

To invert the colors:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Choose Inverse from the Pick menu.
3 Click either mouse button outside the cutout to paste the inverted colors on the drawing area.

Related Tools
Keyboard Procedure



Tools
Pick Tool
Scissors Tool



Choosing Fonts and Font Sizes
The Font menu lists all available fonts. The Size menu lists a range of font sizes for all the fonts. The 
availability of point sizes depends on the resolution available with your printer. If no printer is installed, 
the available point sizes are based on the screen resolution of your video display.
Fonts and font sizes you select affect text in the drawing area and text you type until you select a tool, 
use a scroll bar, switch to another application, resize the window, or reposition the text cursor.

To choose a font:
Select the font name from the Font menu.

To select a font size:
Select the font size from the Size menu.

Available font sizes appear in black. Unavailable font sizes are dimmed. Asterisks indicate precision-
drawn font sizes provided by a font file. Font sizes without an asterisk are scaled by Windows to 
approximate the size.

Related Tool
Keyboard Procedure



Changing Text Styles
You can use various font styles to emphasize text, including bold, italics, underline, and outline. You can 
also create a shadow around text in the currently selected background color.

To change the text style:
Choose the style from the Style menu.

You can select more than one style for the same text. To cancel a style, choose the style again.
The styles you select affect text until you select a tool, use a scroll bar, switch to another application, 
resize the window, or reposition the text cursor.

To cancel all current style selections:
Choose Normal from the Style menu.
Related Tool
Keyboard Procedure



Entering Text

To use text in your drawing:
1 Select the foreground color you want to use for the text.
2 Select the Text tool from the Toolbox.
3 Choose the font and font size you want to use.
4 Choose a style for the font.
5 Move the pointer into the drawing area, click the mouse button, and start typing.

Related Tool
Keyboard Procedure



Creating Custom Colors
You can create custom colors and patterns by varying the amounts of red, green, and blue (RGB 
components) present in the colors provided by Paintbrush. You can change colors and patterns as you 
work on a drawing. Changing colors and patterns in mid-drawing does not affect your drawing in any 
way other than to provide you with more color options.

To create a custom color:
1 Select a color you want to modify. Then choose Edit Colors from the Options menu.

Or double-click the color in the Palette.
2 Move the scroll boxes to increase or decrease the amount of primary color used in a color.

Click        for an example.
3 Click OK when you are satisfied with the color.

Or click Cancel to return to the drawing with the pre-edited color.
Or click Reset to return to the color provided by Paintbrush at the beginning of a session.

Related Procedure
Keyboard Procedure



example
Imagine that each scroll bar controls the brightness of a red, green, and blue flashlight. Moving the scroll
box to the right increases the amount of that RGB component present in the color, lightening it. Moving 
the scroll box to the left decreases the amount of that RGB component present, darkening the color.
If you shine the three flashlights at the same point on a piece of paper, the color where the beams of 
light meet is the composite color. This composite is what you see in the large rectangle to the right of the
scroll bars.



Saving and Retrieving Custom Color Files
Use the Save Colors and Get Colors commands to save and retrieve color palettes to which you've 
added custom colors.

To save a custom color file:
1 Choose Save Colors from the Options menu.
2 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
The .PAL extension is automatically assigned to the filename if you don't specify an extension. If you 
specify an extension, it overrides any automatic extension.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

3 Click OK.    

To retrieve a custom color file:
1 Choose Get Colors from the Options menu.
2 If the file is in the current directory, double-click the name of the file in the Files box.    

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Creating Custom Colors



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and click OK.



hint
To find files with an extension other than .PAL, type that extension in the Filename box and then click 
OK.



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



Using the Cursor Position Option
The Cursor Position command displays the current pointer position as an x-y coordinate. You can use 
these width and height coordinates to align text or lines in your drawings. It is particularly helpful when 
you create charts and tables.

To display the current pointer position as an x-y coordinate:
1 Choose Cursor Position from the View menu.

The Cursor Position window appears on the right side of the title bar above the drawing area. You can
move it to any position outside the drawing area.

2 Move the pointer around the drawing area.
The coordinates inside the Cursor Position window change to indicate the position of the cursor. The 
coordinates register only while the cursor is inside the drawing area. If you move the cursor outside 
the drawing area, the last valid coordinates remain showing in the window until you move back inside 
the drawing area.

3 Choose Cursor Position again to remove the window.
Keyboard Procedure



Printing Drawings
If you have connected and installed a printer, you can print your drawing. Paintbrush automatically prints
to the default printer.

To print the current drawing:
1 Choose Print from the File menu.
2 Select the options you want.

This option Prints
Draft An unenhanced copy of the drawing using the fastest printer speed.

A few printers support only one setting for printing, in which case you will 
not notice any difference between Draft and Proof.

Proof A copy of the drawing that uses the printer's advanced features.
Whole The entire drawing, including parts not showing in the drawing area.
Partial Part of the drawing.
Number of Copies A specific number of copies.
Use Printer Resolution At printer resolution rather than screen resolution. 

Since the dimensions of a pixel on a printer may be different from those for 
a pixel on a screen, Paintbrush must stretch a drawing to produce the same
dimensions on the printed page as you see on the screen.

Scaling To the scale you specify. Scaling by 100 percent implies no scaling.
3 Click OK.

Related Procedures
Keyboard Procedure



Procedures
Changing Printers and Printer Options
Installing New Printers



Printing Part of a Drawing
If you have connected and installed a printer, you can print part of your drawing. Paintbrush 
automatically prints to the default printer.

To print part of a drawing:
1 Choose Print from the File menu and select the Partial option.
2 Click OK.

Paintbrush adjusts the size of your drawing so that the entire image is displayed on the screen, and 
the cursor becomes a flexible rectangle.

3 Press the mouse button where you want to anchor one corner of the flexible rectangle.
4 Drag the rectangle until it contains the portion of the drawing you want to print.
5 Release the mouse button.

Paintbrush prints the selected portion of the drawing.
Related Procedures
Keyboard Procedure



Procedures
Installing New Printers
Printing Drawings



Changing Printers and Printer Options
If you have several printers connected to your computer and designated as active printers, you can print 
to one of these printers by selecting it as the default printer.

To change printers:
1 Choose Printer Setup from the File menu.
2 Select the printer that you want to print on.
3 Choose Setup to change printer options.

In the dialog box that appears, the available options depend on the printer you choose.
4 Select the options you want.

For more information on the options, click the Help button in the printer's Setup dialog box.
5 Click OK to close the printer's Setup dialog box.
6 Click OK.

Related Procedure
Keyboard Procedure



Printing Headers and Footers
When you print your documents, you can add explanatory text, the date, a page number, or the filename
as a header or footer on the printed pages. You can also choose whether you want a header or footer to 
be left-justified, right-justified, or centered on the page.

To add a header or footer to the printed document:
1 Choose Page Setup from the File menu.
2 Type the text you want to use as a header or footer in the Header or Footer box along with any of the 

following codes:

Type For
&d The current date.
&p Page numbers.
&f The current filename.
&l Header or footer text (typed following the code) justified at the left margin.
&r Header or footer text (typed following the code) justified at the right margin.
&c Header or footer text (typed following the code) centered between the margins.
&t The current time.
You can include any or all of these codes in a single header or footer. Headers always appear just 
above the top margin and footers appear just below the margin.

3 Click OK.
Related Procedure
Keyboard Procedure



Setting Margins
Paintbrush prints your drawing using the margin settings specified in the Page Setup dialog box. If you 
want to position your drawing differently on the page, Paintbrush lets you adjust the margins.

To set the margins:
1 Choose Page Setup from the File menu.
2 Type the margin settings in the Margins box.

Paintbrush warns you if your margin settings are too small for the size of your drawing. If your margin 
settings are larger than the size of your drawing, Paintbrush positions the upper-left corner of the 
drawing according to the settings in the Top and Left margin boxes.

3 Click OK.
Related Procedure
Keyboard Procedure



Opening Existing Files
To open an existing file:
1 Choose Open from the File menu.
2 If the file is in the current directory, select the name of the file in the Files box.

You can select one of the Open From options to find files with a specified extension. Or, type a 
different extension in the Filename box and click OK.
If the file is not in the current directory, double-click the directory you want in the Directories box. Then
select the name of the file in the Files box.    

3 Click the Info button to see the height, width, and number of colors and planes used in the drawing. 
Then click OK.

4 Click OK.    
Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Using Microsoft Paint Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



Using Microsoft Paint Files
You can convert a Microsoft Paint file to a Paintbrush file; however, you cannot use Paintbrush to work 
with a Paint file and then resave it as a Paint file.

To convert a Microsoft Paint file to a Paintbrush file:
1 Choose Open from the File menu.
2 Choose MSP from the Open From area to find files with the Paint (.MSP) extension.
3 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

4 Click OK to confirm that the file should be converted to a Paintbrush file.
5 Edit the drawing if you want to.
6 Choose Save from the File menu when you finish.

Paintbrush automatically assigns the extension .BMP to the old filename and saves the drawing.
Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Opening Existing Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



Saving Existing Files
To save changes to an existing drawing:

Choose Save from the File menu.
Related Procedure
Keyboard Procedure



Saving New or Renaming Existing Files
Use the Save As command to name and save a new file or to save an existing file under a new name. 
Click        for an example of renaming a file.
You can save your Paintbrush drawings as Paintbrush files or as bitmap files in four formats. Unless you
change the format in the Save As dialog box, Windows automatically saves a new drawing as a 
Windows bitmap file. It saves a drawing that you open and edit in the same format that it was opened in.

To save a new drawing or the current drawing under a different name:
1 Choose Save As from the File menu.
2 If you want to save the file in the current directory, type the filename.

If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

3 Choose Options to specify the format in which to save the file.
You should save images in one of the Windows bitmap formats whenever possible, in order to 
maintain the highest possible level of compatibility across machines and future versions of Windows.
To avoid using up more memory and disk space than is required, you should always use the bitmap 
format that most closely matches the number of colors used in the picture.

4 Click the Info button to see the height, width, and number of colors and planes in the file. Then click 
OK.

5 Click OK.    
Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Saving Existing Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and click OK.



hint
If you want to make changes to an existing file without modifying the original, use Save As to save 
another copy of the original file by giving it another name.
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Mouse Equivalent Keys
Movement Keys



Editing Keys
Use the following keys for editing a drawing:

To delete Press

All or a portion of what you have drawn since 
selecting a tool. The key changes the pointer,
which you can then drag to erase your 
drawing.

BACKSPACE

Everything you have drawn since selecting a 
tool.

ALT+BACKSPACE

Use the following keys for editing text in Paintbrush:

To delete Press

The character to the left of the insertion point 
in the drawing area or a text box.
Or selected text.

BACKSPACE

The character to the right of the insertion 
point in a text box.
Or selected text.

DEL

Mouse Equivalent Keys

Mouse Action Press

Clicking the left mouse button INS

Double-clicking the left mouse button INS+F9

Clicking the right mouse button DEL

Double-clicking the right mouse button DEL+F9

Movement Keys
Use the following keys for moving among and inside Paintbrush windows:

To move Press

The pointer among the Toolbox, Linesize box,
Palette, and Drawing Area in a counter-
clockwise direction

TAB

The pointer among the Toolbox, Linesize box,
Palette, and Drawing Area in a clockwise 
direction

SHIFT+TAB

The pointer inside a window ARROW KEYS

To the left edge of the drawing SHIFT+HOME

To the right edge of the drawing SHIFT+END

Up one screen PAGE UP

Down one screen PAGE DOWN



To the left one space SHIFT+LEFT ARROW

To the right one space SHIFT+RIGHT 
ARROW

Up one line SHIFT+UP ARROW

Down one line SHIFT+DOWN 
ARROW
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Keyboard: Changing Default Settings for New Drawings
To change default settings for a new drawing:
1 Press ALT and then O.
2 Press I.
3 Press ALT+D to return the drawing area to the original size used to accommodate your video display. 

Then skip to step 8.
Or complete steps 4 through 7.

4 Type the width you want.
5 Press TAB and type the height you want.
6 Press TAB and press the UP ARROW or DOWN ARROW to select inches (in), centimeters (cm), or picture 

elements (pels).
7 Press TAB and press the UP ARROW or DOWN ARROW to select Colors or Black and White.
8 Press ENTER.
9 Press CTRL+N to start a drawing with the new settings.

Mouse Procedure



Keyboard: Starting New Drawings
To start a new drawing:
1 Select a new background color for your drawing if you want to.
2 Change the default settings for the drawing if you want to.
3 Press CTRL+N.

Mouse Procedure



Keyboard: Selecting Background and Foreground Colors
To select a different background and foreground color:
1 Press TAB until the pointer reaches the color palette, use the arrow keys to move the pointer to a 

color, and press DEL to select a background color.
2 Press CTRL+N to set the background color for the drawing.
3 Use the arrow keys to move the pointer to a color and press INS to select a foreground color.

Mouse Procedure



Keyboard: Selecting a Drawing Width
To select a drawing width:
1 Press TAB until the pointer reaches the Linesize box.
2 Use the UP ARROW or DOWN ARROW to move the pointer to a width.
3 Press INS.

Mouse Procedure



Keyboard: Selecting and Using a Drawing Tool
To select and use a drawing tool:
1 Press TAB until the pointer reaches the Toolbox.
2 Use the arrows keys to move the pointer to the Airbrush, Brush, or Paint Roller tool.
3 Press INS.
4 Press TAB until the pointer reaches the drawing area.
5 Use the arrow keys to move the pointer where you want to start drawing.
6 Press and hold down INS.
7 Use the arrow keys to draw with the tool.

Or skip this step if you're using the Paint Roller tool.
8 Release INS.

Mouse Procedure



Keyboard: Editing Graphics
To delete everything you have drawn since selecting a tool:
1 Press ALT and then E.
2 Press U.

To delete a portion of what you have drawn since selecting a tool:
1 Press BACKSPACE.
2 Use the arrow keys to move the pointer where you want to start deleting.
3 Press and hold down INS.
4 Use the arrow keys to delete parts of the drawing.
5 Release INS.

Mouse Procedure



Keyboard: Showing the Entire Screen
To display your drawing on the entire screen:

Press CTRL+C.
Or press TAB until the pointer reaches the Toolbox, use the arrow keys to move the pointer to the Pick 
tool, and press F9+INS.

Related Procedure
Mouse Procedure



Keyboard: Displaying All of a Drawing
To display all of a drawing that is larger than the drawing area:

Press CTRL+O.
Related Procedure
Mouse Procedure



Keyboard: Enlarging the Drawing Area
To enlarge the drawing area:
1 Press ALT and then V.
2 Press T to remove the Toolbox and Linesize Box.

Or press P to remove the Palette.
Related Procedures
Mouse Procedure



Procedures
Displaying All of a Drawing
Showing the Entire Screen



Keyboard: Editing with Zoom In
To magnify a portion of a drawing and change a pixel at a time:
1 Press CTRL+Z.
2 Use the arrow keys to move the pointer over the area you want to magnify.
3 Press INS.
4 Use the arrow keys to move the pointer to a pixel you want to edit.
5 Press INS to change a pixel to the foreground color.

Or press DEL to change a pixel to a background color.
Or use the Paint Roller tool to change an area within the magnified area.

6 Press CTRL+O when you finish.
Or press ALT+BACKSPACE to return to the normal resolution and cancel any changes made to your 
drawing.

Mouse Procedure



Keyboard: Copying, Cutting, and Pasting Cutouts
To copy and paste or cut and paste a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Press CTRL+INS to copy the cutout.

Or press SHIFT+DEL to cut the cutout.
3 Open the file into which you want to paste the cutout.
4 Press SHIFT+INS.
5 Use the arrow keys to move the pointer inside the cutout.
6 Press and hold down INS to paste the cutout transparently.

Or press and hold down DEL to paste the cutout opaquely.
7 Use the arrow keys to move the cutout where you want it.
8 Release INS.
9 Select any tool in order to paste down the cutout.

Related Topics
Mouse Procedure



Information
Transparent and Opaque Pasting and Sweeping

Tools
Pick Tool
Scissors Tool



Keyboard: Moving Cutouts
To move a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Use the arrow keys to move the pointer inside the cutout.
3 Press and hold down INS to paste the cutout transparently.

Or press and hold down DEL to paste the cutout opaquely.
4 Use the arrow keys to move the cutout where you want it.
5 Release INS.
6 Select any tool in order to paste down the cutout.

Related Topics
Mouse Procedure



Keyboard: Sweeping Cutouts
To sweep a succession of cutout copies across the drawing area:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Use the arrow keys to move the pointer inside the cutout.
3 Press INS to paste the cutout transparently.

Or press DEL to paste the cutout opaquely.
4 Press and hold down CTRL.
5 Use the arrow keys to sweep the cutouts.
6 Release CTRL and the mouse button when you finish.
7 Select any tool in order to paste down the changes.

Related Topics
Mouse Procedure



Keyboard: Saving Cutouts
To save a cutout to a file:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Press ALT and then E.
3 Press O.
4 If you want to save the file in the current directory, type the filename.

If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

5 Press ALT+O and press the UP ARROW or DOWN ARROW key to select the format in which to save the 
cutout.

6 Press ALT+I to see the height, width, and number of colors and planes in the cutout. Then press 
ENTER.

7 Press ENTER.    
Related Topics
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Retrieving Cutouts

Tools
Pick Tool
Scissors Tool



Keyboard: Retrieving Cutouts
To retrieve a cutout from a file:
1 Press ALT and then E.
2 Press F.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
Press ALT+B (BMP), ALT+M (MSP), or ALT+P (PCX) to find files with a specified extension. Or, press 
ALT+N and type a different extension in the Filename box. Then press ENTER.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ALT+I to see the height, width, and number of colors and planes in the cutout. Then press 
ENTER.

5 Press TAB until the OK button is selected and then press ENTER.    
6 Use the arrow keys to move the pointer inside the flexible box in the upper-left corner of the drawing 

area.
7 Press and hold down INS.
8 Use the arrow keys to move the cutout where you want it.
9 Release INS.
10 Select any tool in order to paste down the cutout.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Saving Cutouts



Keyboard: Flipping Cutouts
To flip a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Press ALT and then P.
3 Press H (Flip Horizontal) or V (Flip Vertical).
4 Select any tool in order to paste down the cutout.

Related Tools
Mouse Procedure



Tools
Pick Tool
Scissors Tool



Keyboard: Tilting Cutouts
To tilt a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Press ALT and then P.
3 Press T.
4 Press ALT and then P if you want to cut the original cutout area after tilting the cutout. Then press C.
5 Use the arrow keys to move the pointer where you want to anchor the upper-left corner of the flexible 

box that you use to determine the angle of tilt.
6 Press and hold down INS when the pointer is where you want to anchor a corner of a flexible box.
7 Press the LEFT ARROW or RIGHT ARROW key.
8 Release INS.
9 Select any tool in order to paste down the cutout.

Related Tools
Mouse Procedure



Keyboard: Shrinking and Enlarging Cutouts
To change the size of a cutout:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Press ALT and then P.
3 Press S.
4 Press ALT and then P if you want to remove the original cutout area after shrinking or enlarging the 

cutout. Then press C.
5 Use the arrow keys to move the pointer to where you want to anchor the upper-left corner of the 

flexible box that you use to change the dimensions of your cutout.
6 Press and hold down INS.

Or press and hold down INS, then press and hold down SHIFT to keep the cutout at the same 
proportions as the original.

7 Press the LEFT ARROW or RIGHT ARROW to expand the box horizontally.
8 Press the UP ARROW or DOWN ARROW to expand the box vertically.
9 Release INS.
10 Select any tool in order to paste down the cutout.

Related Tools
Mouse Procedure



Keyboard: Inverting Colors in Cutouts
To invert the colors:
1 Use the Pick tool or Scissors tool to define the cutout.
2 Press ALT and then P.
3 Press I.
4 Press INS to paste the inverted colors on the drawing area.

Related Tools
Mouse Procedure



Keyboard: Selecting a Tool
To select a drawing tool:
1 Press TAB until the pointer reaches the Toolbox.
2 Use the arrows keys to move the pointer to the tool.
3 Press INS.



Keyboard: Choosing Fonts and Font Sizes
To choose a font and font size:
1 Press ALT and then N.
2 Use the UP ARROW or DOWN ARROW to select the font and press ENTER.
3 Press ALT+Z and use the arrow keys to select a font size.
4 Press ENTER.

Related Tool
Mouse Procedure



Keyboard: Changing Text Styles
To change the text style:
1 Press ALT and then S. Then press the underlined letter representing the style you want on the menu or

press N to cancel current style selections.
Or press CTRL+B (Bold), CTRL+I (Italic), or CTRL+U (Underline).

2 Repeat step 1 for each additional style you want.
Related Tool
Mouse Procedure



Keyboard: Entering Text

To use text in your drawing:
1 Select the foreground color you want to use for the text.
2 Select the Text tool from the Toolbox.
3 Choose the font and point size you want to use.
4 Choose a style for the font.
5 Press TAB until the pointer reaches the drawing area, press INS, and start typing.

Related Tool
Mouse Procedure



Keyboard: Creating Custom Colors
To create a custom color:
1 Select a color you want to change to a custom color.
2 Press ALT and then O. Then press E.

Or press TAB until the pointer reaches the Color Palette, use the arrow keys to move the pointer to a 
color, and press F9+INS.

3 Press TAB until you select the text box (Red, Green, or Blue) you want to use to increase or decrease 
the amount of a primary color.

4 Type a number from 0 to 255.
5 Repeat steps 3 and 4 to change the amount of another primary color.
6 Press ENTER.

Or press ESC to return to the pre-edited color.
Or press ALT+E to return to the color originally provided by Paintbrush.

Related Procedure
Mouse Procedure



Keyboard: Saving and Retrieving Custom Color Files
To save a custom color file:
1 Press ALT and then O.
2 Then press S.
3 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ENTER.    

To retrieve a custom color file:
1 Press ALT and then O.
2 Press G.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ENTER.    
Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Creating Custom Colors



Keyboard: Using the Cursor Position Option
To display the current cursor position as an x-y coordinate:
1 Press ALT and then V.
2 Press C.
3 Use the arrow keys move the cursor around the drawing area.
4 Choose Cursor Position again to remove the window.

Mouse Procedure



Keyboard: Printing Drawings
To print the current drawing:
1 Press ALT and then F.
2 Press P.
3 Type the number of copies you want.
4 Press TAB and type the percentage of scaling you want.
5 Press TAB and press SPACEBAR to use the printer resolution rather than the screen resolution.
6 Press TAB and use the UP ARROW or DOWN ARROW to specify draft or proof quality of printing.
7 Press TAB and use the UP ARROW or DOWN ARROW to specify whether you want to print a whole 

drawing or part of a drawing.
8 Press ENTER.
9 Complete the procedure for printing part of a drawing if you chose Partial.

Related Procedure
Mouse Procedure



Keyboard: Printing Part of a Drawing
To print part of a drawing:
1 Choose the Partial option in the Print dialog box.
2 Use the arrow keys to move the pointer where you want to anchor one corner of the flexible box.
3 Press and hold down INS.
4 Press the LEFT ARROW or RIGHT ARROW to expand the box horizontally.
5 Press the UP ARROW or DOWN ARROW to expand the box vertically.
6 Release INS when the box contains the portion of the drawing you want to print.

Related Procedure
Mouse Procedure



Keyboard: Changing Printers and Printer Options
To change printers:
1 Press ALT and then F.
2 Press R.
3 Use the UP ARROW or DOWN ARROW to select the printer that you want.
4 Press ALT+S to change printer options.
5 Select the options you want and press ENTER.
6 Press ENTER.

Mouse Procedure



Keyboard: Printing Headers and Footers

To add a header or footer to the printed document:
1 Press ALT and then F.
2 Press T.
3 Type the header text and/or codes. Then press TAB and type the footer text and/or codes.

Type For
&d The current date.
&p Page numbers.
&f The current filename.
&l Header or footer text (typed following the code) justified at the left margin.
&r Header or footer text (typed following the code) justified at the right margin.
&c Header or footer text (typed following the code) centered between the margins.
&t The current time.

3 Press ENTER.
Related Procedure
Mouse Procedure



Keyboard: Setting Margins
To set the margins:
1 Press ALT and then F.
2 Press T.
3 Press TAB until you reach a margin you want to change.
4 Type the new margin.
5 Repeat steps 3 and 4 to change other margins.
6 Press ENTER.

Related Procedure
Mouse Procedure



Keyboard: Opening Existing Files
To open an existing file:
1 Press ALT and then F.
2 Press O.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
Press ALT+B (BMP), ALT+M (MSP), or ALT+P (PCX) to find files with a specified extension. Or, press 
ALT+N and type a different extension in the Filename box. Then press ENTER.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ALT+I to see the height, width, and number of colors and planes used in the drawing. Then 
press ENTER.

5 Press ENTER.    
Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Using Microsoft Paint Files



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the files and directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Using Microsoft Paint Files
To convert a Microsoft Paint file to a Paintbrush file:
1 Press ALT and then F.
2 Press O.
3 Press ALT+M to find files with the Paint (.MSP) extension.
4 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

5 Press ENTER to confirm that the file should be converted to a Paintbrush file.
6 Edit the drawing if you want to.
7 Press CTRL+S when you finish.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Opening Existing Files



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Saving Existing Files
To save changes to an existing drawing:

Press CTRL+S.
Related Procedure
Mouse Procedure



Keyboard: Saving New or Renaming Existing Files
To save a new drawing or the current drawing under an additional name:
1 Press ALT and then F.
2 Press A.
3 If you want to save the file in the current directory, type the filename.

If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ALT+O and and use the UP ARROW or DOWN ARROW key to select the format in which you want to 
save the file.

5 Press ALT+I to see the height, width, and number of colors and planes used in an existing drawing. 
Then press ENTER.

6 Press ENTER.    
Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Saving Existing Files



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and press ENTER.







Scissors Tool

Defines a non-rectangular cutout.
To use the Scissors tool, select the tool and move the pointer into the drawing area. Then drag the 
pointer to draw a line around the part of the picture that you want to be a cutout. Release the mouse 
button when you have enclosed the area.
Use the Scissors tool instead of the Pick tool when you want the cutout to follow an object's contours.
If you make a mistake while defining a cutout, click the right mouse button to start over.

Related Tool
Keyboard Version



Pick Tool

Defines a rectangular cutout.
To use the Pick tool, select the tool, move the pointer into the drawing area, and drag the pointer. A 
flexible rectangle stretches from the anchor point to the pointer position. When the rectangle outlines the
area you want to define as a cutout, release the mouse button.
Use the Pick tool instead of the Scissors tool when the cutout's size and shape don't need to be precise.
If you make a mistake while defining a cutout, click the right mouse button to start over.

Related Tool
Keyboard Version



Airbrush

Sprays paint in the drawing area with foreground-colored dots.
To use the Airbrush, select the tool, move the pointer into the drawing area, and drag the pointer. 
Release the mouse button to stop spraying.
The drawing width you choose from the Linesize box determines the diameter of the spray.

Related Procedures
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width



Text Tool

Inserts text in the drawing area.
To use the Text tool, select the tool, move the pointer into the drawing area, click the mouse, and start 
typing.
Paintbrush stops your text entry at the right edge of the drawing area. Press ENTER to start a new line of 
text. Or move the pointer and click to reposition the insertion point. Use the scroll bars to move to and 
enter text in parts of a drawing that are outside the drawing area.
Until you paste down the text, you can select a new foreground color, font, point size, or text style for 
text in the drawing area. You can also use the BACKSPACE key to make changes in text.
NOTE: Text can be drawn only in solid colors--colors in which all pixels are the same color, not a 
combination of colors. If a non-solid color or a pattern is selected for drawing, text will be drawn in the 
solid color that is closest to the chosen color or pattern.    

Related Procedures
Keyboard Version



Procedures
Choosing Fonts and Font Sizes
Changing Text Styles
Selecting Background and Foreground Colors



example
If you are using a monochrome monitor and select a light gray as your foreground color, the text 
characters are drawn in white. If you then change the foreground color to a pattern that is mostly black, 
the characters are redrawn in black.



Color Eraser

Changes portions of the foreground color to the background color or changes every occurrence of one 
color to another color.
To erase, select the tool and then select a foreground and background color. (The foreground color will 
change to the background color.) Then move the pointer into the drawing area and drag the pointer. To 
erase a horizontal or vertical line, hold down SHIFT as you drag the pointer. The drawing width you 
choose from the Linesize box determines the eraser size.
To change every occurrence of one color to another color, select a foreground and background color. 
(The foreground color will change to the background color.) Then double-click the Color Eraser tool.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Eraser



Eraser

Changes the drawing to the background color.
To erase, select the tool, move the pointer into the drawing area, and drag the pointer. The drawing 
width you choose from the Linesize box determines the eraser size.
To erase a horizontal or vertical line, hold down SHIFT as you drag the pointer.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Color Eraser



Paint Roller

Fills a closed area with the foreground color.
To use the Paint Roller, select the tool, move the pointer into the area you want to fill, and click.
If there are any breaks in the shape's border, the color will leak through and fill the entire drawing area, 
stopping at the borders of the drawing area. Choose Undo if this happens. Use the Zoom In command to
close any breaks in the border.
If you fill an object with a pattern rather than a solid color, you won't be able to refill the object. However, 
you can use the Color Eraser to change the pattern to a solid color or a different pattern.

Related Topics
Keyboard Version



Procedures
Editing with Zoom In
Selecting Background and Foreground Colors

Tools
Brush
Color Eraser



Brush

Paints brush strokes in the drawing area.
To paint, select the foreground color, select the tool, and move the pointer into the drawing area. Then 
drag the pointer.
To change the Brush's shape, choose Brush Shapes from the Options menu or double-click the Brush 
tool. Then select one of the Brush shapes and choose OK.
The drawing width you choose from the Linesize box determines the size of the Brush.
To paint a horizontal or vertical line, hold down SHIFT as you drag the pointer.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Paint Roller



Curve

Draws a curved line.
To draw a curve, select the foreground color, select the tool, and move the pointer into the drawing area.
Drag the pointer from where you want to anchor one end of the curve. When the line is the length you 
want, release the mouse button. Drag the pointer again to stretch the curve in a different direction. When
you are satisfied with the angle of the curve, release the mouse button.
To curve the line in only one direction, click the second end point. To curve the line in two directions, 
drag the pointer away from the first curve to bend the line in the opposite direction. When you are 
satisfied with the curve, release the mouse button.
Until you click the second end point or release the left mouse button to create a line curving in two 
directions, you can click the right button to undo the curve and start over.
The drawing width you choose from the Linesize box determines the line thickness.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Line



Line

Draws a line.
To draw a line, select the foreground color, select the tool, and move the pointer into the drawing area. 
Then drag the pointer. A flexible line stretches from the anchored end to the pointer position. When you 
are satisfied with the line, release the mouse button to paste down the line.
If you are not satisfied with the line, click the right mouse button while holding down the left button to 
undo the line.
To draw a horizontal, vertical, or diagonal line, hold down SHIFT as you drag the pointer.
The drawing width you choose from the Linesize box determines the line thickness.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Curve



Box

Draws a box with straight corners.
To draw a box, select the foreground color, select the tool, and move the pointer into the drawing area. 
Then drag the pointer. A flexible rectangle stretches from the anchor point to the pointer position. When 
you are satisfied with the rectangle size, release the mouse button. Until you release the left mouse 
button, you can click the right button to start over.
To draw a square, hold down SHIFT as you drag the pointer.
The drawing width you choose from the Linesize box determines the thickness of the box's border.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tools
Filled Box
Filled Rounded Box



Rounded Box

Draws a box with rounded corners.
To draw a box, select the foreground color, select the tool, and move the pointer into the drawing area. 
Then drag the pointer. A flexible rectangle stretches from the anchor point to the pointer position. When 
you are satisfied with the rectangle size, release the mouse button. Until you release the left mouse 
button, you can click the right button to start over.
To draw a square, hold down SHIFT as you drag the pointer.
The drawing width you choose from the Linesize box determines the thickness of the box's border.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tools
Filled Box
Filled Rounded Box



Filled Box

Draws filled boxes.
To draw a filled box, select background and foreground colors, select the tool, and move the pointer into 
the drawing area. Then drag the pointer. A flexible rectangle stretches from the anchor point to the 
pointer position. When you are satisfied with the rectangle size, release the mouse button. Until you 
release the left mouse button, you can click the right button to start over.
If you want a border, select a background color that's different from the foreground color. The drawing 
width you choose from the Linesize box determines the border's thickness.
To draw a square, hold down SHIFT as you drag the pointer.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tools
Box
Rounded Box



Filled Rounded Box

Draws filled rounded boxes.
To draw a filled box, select background and foreground colors, select the tool, and move the pointer into 
the drawing area. Then drag the pointer. A flexible rectangle stretches from the anchor point to the 
pointer position. When you are satisfied with the rectangle size, release the mouse button. Until you 
release the left mouse button, you can click the right button to start over.
If you want a border, select a background color that's different from the foreground color. The drawing 
width you choose from the Linesize box determines the border's thickness.
To draw a square, hold down SHIFT as you drag the pointer.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tools
Box
Rounded Box



Circle/Ellipse

Draws a circle or ellipse.
To draw an ellipse, select the foreground color, select the tool, and move the pointer into the drawing 
area. Then drag the pointer. A flexible ellipse stretches from the anchor point to the pointer position. 
When you are satisfied with the ellipse, release the mouse button. Until you release the left mouse 
button, you can click the right button to start over.
To draw a circle, hold down SHIFT as you drag the pointer.
The drawing width you choose from the Linesize box determines the thickness of the circle's or ellipse's 
border.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Filled Circle/Ellipse



Filled Circle/Ellipse

Draws a filled circle or filled ellipse.
To draw a filled ellipse, select background and foreground colors, select the tool, and move the pointer 
into the drawing area. Then drag the pointer. A flexible ellipse stretches from the anchor point to the 
pointer position. When you are satisfied with the ellipse, release the mouse button. Until you release the 
left mouse button, you can click the right button to start over.
If you want a border, select a background color that's different from the foreground color. The drawing 
width you choose from the Linesize box determines the border's thickness.
To draw a filled circle, hold down SHIFT as you drag the pointer.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Circle/Ellipse



Polygon

Draws polygons by connecting straight lines.
To draw polygons, select the foreground color, select the tool, and move the pointer into the drawing 
area. Then drag the pointer. Release the mouse button when you reach the point where you want the 
first side of the polygon to end. Continue adding sides until you want to complete the polygon. Double-
click to add the last line. To start the polygon over, click the right mouse button before double-clicking.
To draw horizontal, vertical, or diagonal lines for the polygon, hold down SHIFT as you drag the pointer.
The drawing width you choose from the Linesize box determines the border's thickness.
To draw lines without dragging the pointer, move the pointer where you want a line to end and click.

Related Tool
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Filled Polygon



Filled Polygon

Draws filled polygons by connecting straight lines.
To draw filled polygons, select background and foreground colors, select the tool, and move the pointer 
into the drawing area. Then drag the mouse. Release the mouse button where you want the first side of 
the polygon to end. Continue adding sides until you complete the polygon. Double-click to add the last 
line. To start the polygon over, click the right mouse button before double-clicking.
If you want a border, select a background color that's different than the foreground color. The drawing 
width you choose from the Linesize box determines the border's thickness.
To draw horizontal, vertical, or diagonal lines for the polygon, hold down SHIFT as you drag the pointer.
To draw lines without dragging the pointer, move the pointer where you want a line to end and click.

Related Topics
Keyboard Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width

Tool
Polygon







Keyboard: Scissors Tool

Defines a non-rectangular cutout.
To use the Scissors tool, select the tool and press TAB until the pointer reaches the drawing area. Use 
the arrow keys to move the pointer where you want to start the cutout and press and hold down INS. 
Then use the arrow keys to draw a line around the part of the picture that you want to be a cutout. 
Release INS when you have outlined the area.
Use the Scissors tool instead of the Pick tool when you want the cutout to follow an object's contours.
If you make a mistake while defining a cutout, start over by releasing INS, pressing an arrow key, and 
pressing INS again.

Related Topics
Mouse Version



Procedure
Selecting a Tool

Tool
Pick Tool



Keyboard: Pick Tool

Defines a rectangular cutout.
To use the Pick tool, select the tool and press TAB until the pointer reaches the drawing area. Use the 
arrow keys to move the pointer where you want to anchor one corner of the flexible rectangle. Then 
press and hold down INS, and press the arrow keys until the rectangle outlines the area that you want to 
define. Release INS.
Use the Pick tool instead of the Scissors tool when the cutout's size and shape don't need to be precise.
If you make a mistake while defining a cutout, start over by releasing INS, pressing an arrow key, and 
pressing INS again.

Related Topics
Mouse Version



Procedure
Selecting a Tool

Tool
Scissors Tool



Keyboard: Airbrush

Sprays paint in the drawing area with foreground-colored dots.
To use the Airbrush, select the tool and press TAB until the pointer reaches the drawing area. Then use 
the arrow keys to move the pointer into the drawing area, press and hold down INS, and use the arrow 
keys to spray in the drawing area. Release INS to stop spraying.
The drawing width you choose from the Linesize box determines the diameter of the spray.

Related Procedures
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool



Keyboard: Text Tool

Inserts text in the drawing area.
To use the Text tool, select the tool and press TAB until the pointer reaches the drawing area. Then press
INS and start typing.
Paintbrush stops your text entry at the right edge of the drawing area. Press ENTER to start a new line of 
text. Or reposition the insertion point by pressing the arrow keys to move the pointer and pressing INS. 
Use Paintbrush's movement keys (see Related Topics) to move to and enter text in other parts of a 
drawing that is larger than the drawing area.
Until you paste down the text, you can select a new foreground color, font, point size, or text style for 
text in the drawing area. You can also use BACKSPACE to make changes in text.
NOTE: Text can be drawn only in solid colors--colors in which all pixels are the same color, not a 
combination of colors. If a non-solid color or a pattern is selected for drawing, text will be drawn in the 
solid color that is closest to the chosen color or pattern.    

Related Procedures
Mouse Version



Procedures
Choosing Fonts and Font Sizes
Changing Text Styles
Selecting a Tool



Keyboard: Color Eraser

Changes portions of the foreground color to the background color or changes every occurrence of one 
color to another color.
To erase, select the tool and then select a foreground and background color. (The foreground color will 
change to the background color.) Then press TAB until the pointer reaches the drawing area and use the 
arrow keys to move the pointer where you want to start erasing. Press and hold down INS, and use the 
arrow keys to erase.
To erase a horizontal or vertical line, press and hold down SHIFT after you press and hold down INS. The 
drawing width you choose from the Linesize box determines the eraser size.
To change every occurrence of one color to another color, select a foreground and background color. 
(The foreground color will change to the background color.) Then press TAB until the pointer reaches the 
Toolbox, use the arrow keys to move the pointer to the Color Eraser, and press F9+INS.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Tool

Tool
Eraser



Keyboard: Eraser

Changes the drawing area to the background color.
To erase, select the tool and press TAB until the pointer reaches the drawing area. Then use the arrow 
keys to move the pointer where you want to start erasing, press and hold down INS, and use the arrow 
keys to erase. The drawing width you choose from the Linesize box determines the eraser size.
To erase a horizontal or vertical line, press and hold down SHIFT after you press and hold down INS.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Color Eraser



Keyboard: Paint Roller

Fills a closed area with the foreground color.
To use the Paint Roller, select the tool and press TAB until the pointer reaches the drawing area. Then 
use the arrow keys to move the pointer into the area you want to fill and press INS.
If there are any breaks in the shape's border, the color will leak through and fill the entire drawing area, 
stopping at the borders of the drawing area. Press ALT+BACKSPACE if this happens. Use the Zoom In 
command to close any breaks in the border.
If you fill an object with a pattern rather than a solid color, you won't be able to refill the object. However, 
you can use the Color Eraser to change the pattern to a solid color or a different pattern.

Related Topics
Mouse Version



Procedures
Editing with Zoom In
Selecting a Tool

Tools
Brush
Color Eraser



Keyboard: Brush

Paints brush strokes in the drawing area.
To paint, select the tool and press TAB until the pointer reaches the drawing area. Then use the arrow 
keys to move the pointer into the drawing area, press and hold down INS, and use the arrow keys to 
paint.
To change the Brush's shape, press ALT and then O. Then press B, use the LEFT ARROW or RIGHT ARROW 
key to select a brush shape, and press ENTER.
The drawing width you choose from the Linesize box determines the size of the Brush.
To paint a horizontal or vertical line, press and hold down SHIFT after you press and hold down INS.

Related Procedures
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Paint Roller



Keyboard: Curve

Draws a curved line.
To draw a curve, select the foreground color, select the tool, and press TAB until the pointer reaches the 
drawing area. Then use the arrow keys to move the pointer where you want to anchor one end of the 
curve, press and hold down INS, and use the arrow keys to draw the line. When the line is the length you
want, release INS. Press INS and use the arrow keys to stretch the curve in the direction you want. When 
you are satisfied with the angle of the curve, release INS.
To curve the line in only one direction, press INS. To curve the line in two directions, press and hold down
INS, and press the arrow keys. When you are satisfied with the curve, release INS.
Until you the curve is pasted down, you can press F9+DEL to start over.
The drawing width you choose from the Linesize box determines the line thickness.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Line



Keyboard: Line

Draws a line.
To draw a line, select the foreground color, select the tool, press TAB until the pointer reaches the 
drawing area, and use the arrow keys to move the pointer where you want to start the line. Then press 
and hold down INS to anchor one end of the line and press the arrows keys. A flexible line stretches from
the anchored end to the insertion point. When you are satisfied with the line, release INS to paste down 
the line.
If you are not satisfied with the line, press DEL while holding down INS to undo the line.
To draw a horizontal, vertical, or diagonal line, press and hold down SHIFT after you press and hold INS.
The drawing width you choose from the Linesize box determines the line thickness.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Curve



Keyboard: Box

Draws a box with straight corners.
To draw a box, select the foreground color, select the tool, press TAB until the pointer reaches the 
drawing area, and use the arrow keys to move the pointer where you want to start the box. Then press 
and hold down INS and press the arrow keys. The LEFT ARROW and RIGHT ARROW keys expand or contract
the box horizontally, and the UP ARROW and DOWN ARROW keys expand or contract the box vertically. 
When you are satisfied with the box size, release INS. Until you release INS, you can press DEL to start 
over.
To draw a square, press and hold down SHIFT after you press and hold down INS. When you are satisfied
with the square, release INS before releasing SHIFT.
The drawing width you choose from the Linesize box determines the thickness of the box's border.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tools
Filled Box
Filled Rounded Box



Keyboard: Rounded Box

Draws a box with rounded corners.
To draw a box, select the foreground color, select the tool, press TAB until the pointer reaches the 
drawing area, and use the arrow keys to move the pointer where you want to start the box. Then press 
and hold down INS and press the arrow keys. The LEFT ARROW and RIGHT ARROW keys expand or contract
the box horizontally, and the UP ARROW and DOWN ARROW keys expand or contract the box vertically. 
When you are satisfied with the box size, release INS. Until you release INS, you can press DEL to start 
over.
To draw a square, press and hold down SHIFT after you press and hold down INS. When you are satisfied
with the square, release INS before releasing SHIFT.
The drawing width you choose from the Linesize box determines the thickness of the box's border.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tools
Filled Box
Filled Rounded Box



Keyboard: Filled Box

Draws filled boxes.
To draw a filled box, select background and foreground colors, select the tool, and press TAB until the 
pointer reaches the drawing area. Then use the arrow keys to move pointer where you want to start the 
box, press and hold down INS, and press the arrow keys. The LEFT ARROW and RIGHT ARROW keys 
expand or contract the box horizontally, and the UP ARROW and DOWN ARROW keys expand or contract the
box vertically. When you are satisfied with the box size, release INS. Until you release INS, you can press 
DEL to start over.
If you want a border, select a background color different from the foreground color. The drawing width 
you choose from the Linesize box determines the border's thickness.
To draw a square, press and hold down SHIFT after you press and hold down INS. When you are satisfied
with the square, release INS before releasing SHIFT.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tools
Box
Rounded Box



Keyboard: Filled Rounded Box

Draws filled rounded boxes.
To draw a filled box, select background and foreground colors, select the tool, and press TAB until the 
pointer reaches the drawing area. Then use the arrow keys to move pointer where you want to start the 
box, press and hold down INS, and press the arrow keys. The LEFT ARROW and RIGHT ARROW keys 
expand or contract the box horizontally, and the UP ARROW and DOWN ARROW keys expand or contract the
box vertically. When you are satisfied with the box size, release INS. Until you release INS, you can press 
DEL to start over.
If you want a border, select a background color different from the foreground color. The drawing width 
you choose from the Linesize box determines the border's thickness.
To draw a square, press and hold down SHIFT after you press and hold down INS. When you are satisfied
with the square, release INS before releasing SHIFT.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tools
Box
Rounded Box



Keyboard: Circle/Ellipse

Draws an ellipse.
To draw an ellipse, select the foreground color, select the tool, press TAB until the pointer reaches the 
drawing area, and use the arrow keys to move the pointer where you want to start the ellipse. Then 
press and hold down INS, and press the arrow keys. The LEFT ARROW and RIGHT ARROW keys expand or 
contract the ellipse horizontally, and the UP ARROW and DOWN ARROW keys expand or contract the ellipse 
vertically. When you are satisfied with the ellipse, release INS. Until you release INS, you can press DEL to
start over.
To draw a circle, press and hold down SHIFT after you press and hold down INS. When you are satisfied 
with the circle, release INS before releasing SHIFT.
The drawing width you choose from the Linesize box determines the thickness of the circle's or ellipse's 
border.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Filled Circle/Ellipse



Keyboard: Filled Circle/Ellipse

Draws a filled circle or filled ellipse.
To draw a filled ellipse, select background and foreground colors, select the tool, press TAB until the 
pointer reaches the drawing area, and use the arrow keys to move the pointer where you want to start 
the ellipse. Then press and hold down INS, and press the arrow keys. The LEFT ARROW and RIGHT ARROW 
keys expand or contract the ellipse horizontally, and the UP ARROW and DOWN ARROW keys expand or 
contract the ellipse vertically. When you are satisfied with the ellipse, release INS. Until you release INS, 
you can press DEL to start over.
If you want a border, select a background color different from the foreground color. The drawing width 
you choose from the Linesize box determines the border's thickness.
To draw a circle, press and hold down SHIFT after you press and hold down INS. When you are satisfied 
with the circle, release INS before releasing SHIFT.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Circle/Ellipse



Keyboard: Polygon

Draws polygons out of connected straight lines.
To draw polygons, select the foreground color, select the tool, press TAB until the pointer reaches the 
drawing area, and use the arrow keys to move where you want to start the polygon. Then press and hold
down INS, and press the arrow keys. Release INS when you reach the point where you want the first side
of the polygon to end. Continue adding sides until you want to complete the polygon. Press F9+INS to 
add the last line. To start the polygon over, press DEL before pressing F9+INS.
To draw horizontal, vertical, or diagonal lines for the polygon, press and hold down SHIFT after you press 
and hold down INS.
The drawing width you choose from the Linesize box determines the border's thickness.
To draw lines after the first line without pressing and holding down INS, move the pointer where you want
a line to end and press INS.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Filled Polygon



Keyboard: Filled Polygon

Draws filled polygons out of connected straight lines.
To draw filled polygons, select background and foreground colors, select the tool, press TAB until the 
pointer reaches the drawing area, and use the arrow keys to move the pointer where you want to start 
the filled polygon. Then press and hold down INS, and press the arrow keys. Release INS where you 
want the first side of the polygon to end. Continue adding sides until you complete the polygon. Press 
F9+INS to add the last line. To start the polygon over, press DEL before pressing F9+INS.
If you want a border, select a background color different than the foreground color. The drawing width 
you choose from the Linesize box determines the border's thickness.
To draw horizontal, vertical, or diagonal lines for the polygon, press and hold down SHIFT after you press 
and hold down INS.
To draw lines after the first line without pressing and holding down INS, move the pointer where you want
a line to end and press INS.

Related Topics
Mouse Version



Procedures
Selecting Background and Foreground Colors
Selecting a Drawing Width
Selecting a Tool

Tool
Polygon







Paintbrush
A graphics application with a variety of tools for creating simple or elaborate drawings.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case Paintbrush.

Drag the title bar to move an application window on the screen.



Minimize button          
Click the Minimize button to shrink the Paintbrush window to an icon.



Maximize button          
Click the Maximize button to enlarge the Paintbrush window to its maximum size.



File menu



Edit menu



View menu



Font menu



Style menu



Size menu



Pick menu



Options menu



Help menu



menu bar          
Contains the names of all the Paintbrush menus.

Click a menu name to display the menu commands.



Scissors tool          
Draws a cutout. A cutout is a selected portion of a drawing. You select a portion of a drawing so that you 
can carry out an action that affects the cutout. For example, you can copy and paste cutouts, move 
cutouts, and change the size and shape of cutouts.
Use the Scissors tool instead of the Pick tool when you want the cutout to follow an object's contours.

Select the tool and drag the pointer until the cutout is enclosed.



Pick tool          
Defines a rectangular cutout. A cutout is a selected portion of a drawing. You select a portion of a 
drawing so that you can carry out an action that affects the cutout. For example, you can copy and paste
cutouts, move cutouts, and change the size and shape of cutouts.
Use the Pick tool instead of the Scissors tool when the cutout's size and shape don't need to be precise.

Select the tool and drag the pointer until the cutout is the size you want it.



Airbrush          

Sprays dots in the drawing area.
The drawing width you choose from the Linesize box determines the diameter of the spray. You select 
the color of the spray by choosing a foreground color.

Select the tool and drag the pointer through the drawing area.



Text tool          
Inserts text in the drawing area.
With menu commands, you can choose a font and font size. You can also choose font styles such as 
bold, underline, and italics. You select the color of the text by choosing a foreground color.

Select the tool, move the pointer into the drawing area, and click where you want to start typing.



Color Eraser          
Changes the foreground color to the background color.
Use the Color Eraser if you want to change only one color of many in a drawing. The drawing width you 
choose from the Linesize box determines the eraser size.

Select the color you want to erase as the foreground color, select the tool, and drag the pointer 
through the drawing area.



Eraser          
Changes any color in the drawing to the background color.
The drawing width you choose from the Linesize box determines the eraser size.

Select the tool and drag the pointer through the drawing area.



Paint Roller          
Fills a closed area with the foreground color.

Select the tool, move the pointer inside an object, and click.



Brush          

Paints brush strokes in the drawing area.
Double-click the tool in the toolbox to choose a brush shape. The drawing width you choose from the 
Linesize box determines the size of the Brush. You select the color of the strokes by choosing a 
foreground color.

Select the tool and drag the pointer through the drawing area.



Curve          

Draws a curved line.
You can draw a line that curves in one direction or two. The drawing width you choose from the Linesize 
box determines the line thickness. You select the color of the line by choosing a foreground color.

Select the tool, and drag the pointer first in one direction and then the other to create a simple 
curve.



Line          

Draws a line.
The drawing width you choose from the Linesize box determines the line thickness. You select the color 
of the line by choosing a foreground color.

Select the tool and drag the pointer.



Box          

Draws a box.
The drawing width you choose from the Linesize box determines the thickness of the box's sides. You 
select the color of the sides by choosing a foreground color.

Select the tool and drag the pointer.



Rounded Box          

Draws a box with rounded corners.
The drawing width you choose from the Linesize box determines the thickness of the box's sides. You 
select the color of the sides by choosing a foreground color.

Select the tool and drag the pointer.



Filled Box          

Draws boxes filled with a color.
The drawing width you choose from the Linesize box determines the thickness of the box's border. You 
select the color of the border by choosing a background color and the color of the interior by choosing a 
foreground color.

Select the tool and drag the pointer.



Filled Rounded Box          

Draws rounded boxes filled with a color.
The drawing width you choose from the Linesize box determines the thickness of the box's border. You 
select the color of the border by choosing a background color and the color of the interior by choosing a 
foreground color.

Select the tool and drag the pointer.



Circle/Ellipse          

Draws a circle or ellipse.
The drawing width you choose from the Linesize box determines the thickness of the circle or ellipse. 
You select the color of the circle or ellipse by choosing a foreground color.

Select the tool and drag the pointer.



Filled Circle/Ellipse          

Draws a circle or ellipse filled with a color.
The drawing width you choose from the Linesize box determines the thickness of the circle's or ellipse's 
border. You select the color of the border by choosing a background color and the color of the interior by 
choosing a foreground color.

Select the tool and drag the pointer.



Polygon          

Draws polygons by connecting straight lines.
The drawing width you choose from the Linesize box determines the thickness of the sides. You select 
the color of the polygon by choosing a foreground color.

Select the tool, drag the pointer to create lines, and double-click to complete the polygon.



Filled Polygon          

Draws polygons filled with a color by connecting straight lines.
The drawing width you choose from the Linesize box determines the thickness of the polygon's border. 
You select the color of the border by choosing a background color and the color of the interior by 
choosing a foreground color.

Select the tool, drag the pointer to create lines, and double-click to complete the polygon.



Linesize box          

Determines the width of any lines you make with Paintbrush tools.
Line width affects:

The border size of objects made with the box, circle/ellipse, and polygon tools.
The thickness of lines made with the Line and Curve tool.
The width of Brush strokes and diameter of Airbrush spray.
The size of the erasers.
Move the pointer to a line width and click to choose the line width.



Palette          

Colors you can use in a drawing.
You can choose background and foreground colors for your drawing. You can also change a color on the
palette to a custom color.

Move the pointer to a color, and click the left mouse button to choose a foreground color or click 
the right mouse button to choose a background color.



image          

Example of a drawing you can create in Paintbrush.



pointer          
The object on the screen that follows the mouse's movement and indicates which area of the screen will 
be affected when you click the mouse button. Outside the drawing, the pointer is usually arrow-shaped. 
In the drawing, the pointer is usually cross-shaped. However, if you select the text tool, the pointer 
changes to an I-beam; if you select the Paint Roller, the pointer changes to a Paint Roller.

Move the mouse to move the pointer.



foreground and background colors          

Colors used in a drawing's foreground and background. In the above example, the foreground color 
(black) sits on top of the background color (white). The foreground color is the color you draw with. The 
background color is the color you draw on.

Move the pointer to a color in the palette and click the left button to select a foreground color or 
the right button to select a background color.



drawing area
Area in which you can create your drawings. If the drawing area is smaller than the Paintbrush window, 
a black frame separates it from the gray area (the area where you cannot perform any Paintbrush 
actions).
The drawing area can also contain text or graphics copied from another application.

Choose the Image Attributes command from the Options menu to specify drawing size you want.



application window
The main window for an application, in this case the Paintbrush window. It contains the Paintbrush tools,
pallette, and drawing area where you create paintbrush drawings.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)
Keyboard
Mouse
Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:
The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster
2MB or more of RAM
30MB or larger hard disk
VGA display
A digital audio subsystem
A CD-ROM drive
Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:
The name of the printer.
Where the printer connects to your computer.
The current status of the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






